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Altera provides a free library of parameterizable intellectual property (IP) blocks, called megafunctions, that
are optimized for efficient logic synthesis in Altera devices.

You can quickly customize your own variation of a megafunction in the Quartus II GUI, or you can define
and instantiate megafunctions directly in HDL files. The Quartus II software automatically infers
megafunction code whenever it recognizes HDL code that can be optimized by substituting a megafunction.
Additionally, you must use megafunctions to access certain Altera architecture-specific features within
memory, DSP blocks, and shift registers.

Altera Provided Megafunctions
Altera provides a free library of megafunction IP cores for use in your design.

The latest Altera megafunctions are based on either the hardware Tcl infrastructure, or a non-hardware Tcl
infrastructure. The files generated for your core vary depending on the infrastructure of the IP core. Hardware
Tcl megafunctions generate a Quartus II IP File (.qip) that refers to all megafunction subcomponents,
testbenches, and constraint files for Quartus II synthesis. This single.qip file represents the megafunction
in your project. Non-hardware Tcl megafunctions are represented in your project by the individual output
HDL files that define their logic and constraints.

The Quartus II software includes these megafunctions for use without additional license.

Arithmetic Megafunctions
The Quartus II software includes these arithmetic megafunctions.

IP InfrastructureFunctionMegafunction Name

Non-hardware TclAbsolute valueLPM_ABS

Non-hardware TclAdder/SubtractorLPM_ADD_SUB

Non-hardware TclComparatorLPM_COMPARE

Non-hardware TclCounterLPM_COUNTER

Non-hardware TclDividerLPM_DIVIDE

Non-hardware TclMultiplierLPM_MULT

Non-hardware TclAccumulatorALTACCUMULATE
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IP InfrastructureFunctionMegafunction Name

Non-hardware TclECC Encoder/
Decoder

ALTECC

Non-hardware TclMemory Constant
Coefficient
Multiplier

ALTMEMMULT

Non-hardware TclMultiply-
Accumulator

ALTMULT_ACCUM

Non-hardware TclMultiply-AdderALTMULT_ADD

Non-hardware TclComplex MultiplierALTMULT_COMPLEX

Non-hardware TclInteger Square-RootALTSQRT

Non-hardware TclParallel AdderPARALLEL_ADD

Floating-Point Megafunctions
The Quartus II software includes these floating-point megafunctions.

IP InfrastructureFunctionMegafunction Name

Non-hardware TclAdder/SubtractorALTFP_ADD_SUB

Non-hardware TclDividerALTFP_DIV

Non-hardware TclMultiplierALTFP_MULT

Non-hardware TclSquare RootALT_SQRT

Non-hardware TclExponentialALTFP_EXP

Non-hardware TclInverseALTFP_INV

Non-hardware TclInverse Square RootALTFP_INV_SQRT

Non-hardware TclNatural LogarithmALTFP_LOG

Non-hardware TclArctangentALTFP_ATAN

Non-hardware TclTrigonometric Sine/CosineALTFP_SINCOS

Non-hardware TclAbsolute valueALTFP_ABS

Non-hardware TclComparatorALTFP_COMPARE

Gate Megafunctions
The Quartus II software includes these gate megafunctions.
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IP InfrastructureFunctionMegafunction Name

Non-hardware TclCombinatorial logic shifterLPM_CLSHIFT

Non-hardware TclConstant generatorLPM_CONSTANT

Non-hardware TclDecoderLPM_DECODE

Non-hardware TclMultiplexerLPM_MUX

I/O Megafunctions
The Quartus II software includes these I/O megafunctions.

IP InfrastructureFunctionMegafunction Name

Non-hardware TclLVDS transmitter and receiverALTLVDS

Non-hardware TclPhase-Locked Loop (PLL)ALTPLL

Non-hardware TclPLL reconfigurationALTPLL_RECONFIG

Hardware TclPhase-Locked Loop for Stratix® V
devices only

ALTERA_PLL

Non-hardware TclRemote UpdateALTREMOTE_UPDATE

Non-hardware TclGigabit transceiver block (GXB)ALTGXB

Non-hardware TclOn-Chip TerminationALTOCT

Non-hardware TclClock ControlALTCLKCTRL

Non-hardware TclDouble Data Rate I/OALTDDIO

Non-hardware TclI/O BufferALTIOBUF

Non-hardware TclTemperature SensorALTTEMP_SENSE

Non-hardware TclDelay Locked Loop (DLL)ALTDLL

Non-hardware TclDQ and DQSALTDQ and ALTDQS

Hardware TclDQ and DQS for Stratix VALTDQ_DQS2

Non-hardware TclActive Serial Memory InterfaceALTASMI_PARALLEL

Memory Megafunctions
The Quartus II software includes these memory megafunctions.

IP InfrastructureFunctionMegafunction Name

Non-hardware TclInternal memoriesRAM and ROM
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IP InfrastructureFunctionMegafunction Name

Non-hardware TclSingle clock FIFO and Dual Clock
FIFO

SCFIFO and DCFIFO

Non-hardware TclFirst-In First-Out PartitionerFIFO Partitioner

Non-hardware TclShift-registerLPM_SHIFTREG

Non-hardware TclRAM Shift RegisterALTSHIFT_TAPS

Non-hardware TclUser Flash MemoryALT_UFM

Non-hardware TclOne-Time Programmable functionALTOTP

JTAG Megafunctions
The Quartus II software includes these JTAG extensible megafunctions.

IP InfrastructureFunctionMegafunction Name

Non-hardware TclParallel Flash LoaderPFL

Non-hardware TclVirtual JTAGSLD_VIRTUAL_JTAG

Related Information
Megafunctions and IP Documentation Web Page

Customizing Megafunctions
You can customize a variation of a megafunction IP core for use in your design. Using megafunctions in
your design involves the following steps:

1. Identify the megafunction that best meets your design and target device requirements.
2. To define and instantiate a megafunction using the GUI, click Tools > MegaWizard Plug-In Manager

and follow the wizard to define your megafunction. The Quartus II software automatically generates
synthesis and optional simulation output files.

3. Use the Block Editor or Qsys to connect the megafunction to other elements in the design.
4. Compile your design in the Quartus II software. Optionally generate a netlist for other EDA tools.
5. Simulate your design in your preferred EDA simulator.

Related Information

• Connecting Megafunctions on page 6

• Using HDL Code Templates on page 9

• Synthesizing Megafunctions in other Tools on page 13
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Customizing Megafunctions in the GUI
The MegaWizard Plug-In Manager GUI allows you to define and instantiate a custom variation of an Altera
megafunction. You can edit megafunctions at any time. Megafunctions defined in your project appear in
the Project Navigator. To edit a megafunction, double-click the megafunction file in the Project Navigator
or Block Editor to display the MegaWizard GUI. To customize a megafunction using the MegaWizard
Plug-In Manager GUI, follow these steps:

1. Launch the MegaWizard Plug-In Manager using any of the following methods:

• In the Quartus II software, click Tools > MegaWizard Plug-In Manager.
• In the Project Navigator, right-click a megafunction file and click MegaWizard Plug-In Manager.
• In the Block Editor, click Edit > Insert Symbol as Block. In the Symbol editor, click MegaWizard

Plug-In Manager.
• Start the stand-alone version of the MegaWizard Plug-In Manager GUI by typing the following

command at the command prompt:

qmegawiz (for GUI or command-line mode)

or

qmegawizq (for GUI only)

2. Specify Create, Edit, or Copy a megafunction.
3. In Which device family will you be using? select your target device family.

Only megafunctions available for the target device are available in Whichmegafunction would you like
to customize? Unsupported megafunctions are grayed out.

4. Specify the name and file format of the output file. Click Next
5. Parameterize the megafunction by specifying options in the wizard. Click Next .
6. If the wizard includes EDA and Summary tabs, follow these steps:

• Some third-party synthesis tools can use a grey box netlist that contains the structure of an IP core
without detailed logic to optimize timing and performance of the design containing it. To use this
feature, turn on Generate Netlist to generate a netlist file for area and timing estimation instead of a
wrapper file.

• On the Summary tab, select the files you want to generate. A gray checkmark indicates a file that is
automatically generated. All other files are optional. This step instantiates the megafunction into your
HDL code and creates a wrapper file.

7. Click Finish. The megafunction variation is generated along with the files you specify.
8. To view the megafunction schematic, open the generated block symbol file (.bsf) located in your project

directory. The megafunction block symbol appears in the Symbol window.
You can edit megafunctions at any time. Megafunctions defined in your project appear in the Project
Navigator. To edit a megafunction, double-click the megafunction file in the Project Navigator or Block
Editor to display the MegaWizard GUI.
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Figure 1: Example Parameterized Global Clock Control Module

Related Information
Creating a System with Qsys

Connecting Megafunctions
You can easily visualize and connect megafunctions to other elements of your design with the Quartus II
Block Editor. You can make connections by drawing node (wire), bus, and conduit connections between
blocks representing megafunctions and primitives in the schematic. If the I/O signal names in one block
match those in another connected block, the Quartus II software automatically connects common I/O's
between the blocks. If the I/Os in two connected blocks are differently named, you can assign a name that
matches a block I/O port to connect the port to the bus or conduit, or you can map the signal connection
by name explicitly. You can also connect megafunctions included in a Qsys system in the Qsys GUI. To
connect a megafunction using the block editor, follow these steps:

1. To draw a wire, bus or conduit line connecting one or more block, perform any of the following:

• To draw a conduit, click the Selection and Smart Drawing Tool or the Orthogonal Conduit Tool
button on the toolbar. The smart selection and drawing tool automatically changes to the correct
node, bus, or conduit tool when you drag it from a block or symbol border.

• To draw a bus, click the Orthogonal Bus Tool button on the toolbar.
• To draw a wire, click the Orthogonal Node Tool button on the toolbar.

The Quartus II software automatically connects common I/O's between the blocks
2. To map differently named I/O between two megafunctions, follow these steps:

a. At a conduit connection, double click themapper symbol. TheMapperProperties dialog box appears.
b. On the General tab, specify the I/O Type.
c. Click the Mappings tab.
d. Under Conduit Mappings, select the name of your I/O on block and the corresponding Signals in

conduit.
e. Click Add. A logical connection is created between the signals.

3. In the File menu, click Save.
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Figure 2: Example Global Clock Control Connections

Generated Megafunction Files (Non-Hardware Tcl)
The Quartus II software generates one or more of the following files for non-_hw.tcl-based megafunctions.
The MegaWizard generates a Verilog HDL, VHDL, or AHDL Variation Wrapper File, depending on the
language you select for the output file on the megafunction-selection page of the parameter editor. The
MegaWizard generates the _syn.v file only if you turn on theGenerate a synthesis area and timing estimation
netlist option on the EDA page of the parameter editor. This file is generated in Verilog HDL format
regardless of the HDL language selected.

DescriptionFile

VerilogHDLVariationWrapper File for instantiation
in a Verilog HDL design.

<variant_name>.v

VHDL Variation Wrapper File for instantiation in a
VHDL design.

<variant_name>.vhd

AHDL Variation Wrapper File for instantiation in an
AHDL design.

<variant_name>.tdf

AHDL Include File used in AHDL designs.<variant_name>.inc

Component Declaration File used in VHDL designs.<variant_name>.cmp

Block Symbol File for schematic designs and is used
in Quartus II Block Design Files (.bdf).

<variant_name>.bsf

Verilog HDL Instantiation Template sample Verilog
HDL instantiation of themodule in themegafunction
wrapper file.

<variant_name>_inst.v

VHDL Instantiation Template of the entity in the
megafunction wrapper file.

<variant_name>_inst.vhd

Text Design File Instantiation Template of the
subdesign in the megafunction wrapper file.

<variant_name>_inst.tdf
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DescriptionFile

For supported megafunctions, grey box Verilog HDL
ModuleDeclaration file that is usedwhen instantiating
the megafunction as a grey box in a third-party
synthesis tool. This netlist contains the “grey box”
information for resource and timing estimation, but
does not contain the actual implementation.

<variant_name>_gb.v

Black box Verilog HDL Module Declaration file that
is usedwhen instantiating themegafunction as a black
box in a third-party synthesis tool.

<variant_name>_bb.v

Synthesis area and timing estimation netlist. If you
enable the option to generate a synthesis area and
timing estimation netlist, the MegaWizard Plug-In
Manager generates this additional synthesis netlist
file. This file is the megafunction netlist used by
certain third-party synthesis tools to improve their
area and timing estimates.

<variant_name>_syn.v

Related Information
Synopsys Simplify Support

Generated Megafunction Files (Hardware Tcl)
The Quartus II software generates one or more of the following files for _hw.tcl-based megafunctions. The
MegaWizardPlug-InManager generates aVerilogHDL,VHDL, orAHDLVariationWrapper File, depending
on the language you select for the output file on the megafunction-selection page of the parameter editor.
The simulation script for Synopsys VCS is not generated for VHDL designs.

DescriptionDirectory and Filename

VerilogHDLVariationWrapper File for instantiation
in a Verilog HDL design.

<working directory>\<variant_name>.v

VHDL Variation Wrapper File for instantiation in a
VHDL design.

<working directory>\<variant_name>.vhd

Block Symbol File for schematic designs and is used
in Quartus II Block Design Files (.bdf).

<working directory>\<variant_name>.bsf

Quartus II IP file that refers to all generated files in
the synthesis fileset.

<working directory>\<variant_name>.qip

Wrapper file.<working directory>\<variant_name>\<variant_
name>_0002.v

Verilog simulation model.<working directory>\<variant_name>_sim\<variant_
name>.vo

VHDL simulation model.<working directory>\<variant_name>_sim\<variant_
name>.vho
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DescriptionDirectory and Filename

Simulation script for ModelSim, ModelSim-Altera,
and QuestaSim Mentor Graphics simulators. The
script creates alias commands to compile the required
device libraries and system design files in the correct
order and elaborate or load the top-level design for
simulation.

<working directory>\<variant_name>_sim\mentor\
msim_setup.tcl

Synopsys VCS and VCS MX simulation shell scripts.
The simulation scripts for Synopsys VCS and VCS
MX that contain shell commands to compile the
required device libraries and system design files in the
correct order, and elaborate the top-level design for
simulation and run the simulation for 100 time units
by default.

<working directory>\<variant_name>_sim\synopsys\
vcs_setup.sh

<working directory>\<variant_name>_sim\synopsys\
vcsmx_setup.sh

Cadence Incisive Enterprise simulation shell scripts.
The simulation script for the Cadence Incisive
Enterprise Simulation Shell Script that contains shell
commands to compile the required device libraries
and system design files in the correct order, and
elaborate the top-level design for simulation and run
the simulation for 100 time units by default.

<working directory>\<variant_name>_sim\cadence\
ncsim_setup.sh

For supported megafunctions, grey box Verilog HDL
ModuleDeclaration file that is usedwhen instantiating
the megafunction as a grey box in a third-party
synthesis tool. This netlist contains the “grey box”
information for resource and timing estimation, but
does not contain the actual implementation.

<variant_name>_gb.v

Related Information
Synopsys Simplify Support

Instantiating Megafunctions in HDL
You can instantiate a megafunction directly in your HDL code by calling the megafunction and setting its
parameters as youwould in any othermodule, component, or subdesign. When instantiating amegafunction
in VHDL, be sure to include the correct libraries.

Using HDL Code Templates
The Quartus II software includes code examples or templates for inferred RAMs, ROMs, shift registers,
arithmetic functions, and DSP functions optimized for Altera devices. To access HDL code templates to
define megafunctions, follow these steps:

1. Open a file in the text editor.
2. On the Edit > Insert template.
3. In the Insert Template dialog box, click the + icon to expand either the Verilog HDL category or the

VHDL category, depending on the HDL you prefer.
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4. Under Full Designs, expand the navigation tree to display the type of functions you want to infer.
5. Select the function to display the code for the selected template in the Preview pane, and click Insert.

For new DSP features optimized for Arria V, Cyclone V, and Stratix V, expand the Arithmetic
category, and then expand the DSP features (Stratix-V, Arria-V and Cyclone-V) category.

Note:

Example Top-Level Verilog Module
Verilog HDL ALTFP_MULT in Top-Level Module with One Input Connected to Multiplexer.

module MF_top (a, b, sel, datab, clock, result);
    input [31:0] a, b, datab;
    input clock, sel;
    output [31:0] result;
    wire [31:0] wire_dataa; 

    assign wire_dataa = (sel)? a : b;  
    altfp_mult inst1 (.dataa(wire_dataa), .datab(datab), .clock(clock), 
.result(result));

    defparam 
         inst1.pipeline = 11,
         inst1.width_exp = 8,
         inst1.width_man = 23,
         inst1.exception_handling = "no";    
endmodule

Example Top-Level VHDL Module
VHDL ALTFP_MULT in Top-Level Module with One Input Connected to Multiplexer.

library ieee;
use ieee.std_logic_1164.all; 
library altera_mf;
use altera_mf.altera_mf_components.all; 

entity MF_top is
     port (clock, sel  : in  std_logic;    
           a, b, datab : in  std_logic_vector(31 downto 0);   
           result      : out std_logic_vector(31 downto 0));
end entity;

architecture arch_MF_top of MF_top is
signal wire_dataa : std_logic_vector(31 downto 0);
begin

wire_dataa <= a when (sel = '1') else b;

inst1 : altfp_mult 
     generic map (
             pipeline => 11,
             width_exp => 8,
             width_man => 23,  
             exception_handling => "no")  
     port map (
             dataa => wire_dataa,
             datab => datab,
             clock => clock,
             result => result); 
end arch_MF_top;
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Example Megafunction Inference
The Quartus II software infers following the following Verilog HDL code as the LPM_MULT or
ALTMULT_ADD megafunctions for an unsigned and a signed multiplier. Each example fits into one DSP
block 9-bit element. In addition, when register packing occurs, no extra logic cells for registers are required.

module unsigned_mult (out, a, b);
   output [15:0] out;
   input [7:0] a;
   input [7:0] b;
   assign out = a * b;
endmodule

module signed_mult (out, clk, a, b);
   output [15:0] out;
   input clk;
   input signed [7:0] a;
   input signed [7:0] b;
   reg signed [7:0] a_reg;
   reg signed [7:0] b_reg;
   reg signed [15:0] out;
   wire signed [15:0] mult_out;
   assign mult_out = a_reg * b_reg;
   always @ (posedge clk)
   begin
       a_reg <= a;
       b_reg <= b;
       out <= mult_out;
   end
endmodule

Related Information
Recommended HDL Coding Styles

Quartus II Integrated Synthesis

Using qmegawiz Command-Line Executable
You can use qmegawiz command-line version of the MegaWizard Plug-In Manager that allows you to
modify, update, or create variation files without using a GUI. The following table lists common qmegawiz
syntax options and arguments To use qmegawiz, use the following syntax:

qmegawiz [options] [module=<module name>]| wizard=<wizard name>] 
[<param>=<value>...<port>=<used>|<unused>...] <variation file name>

DescriptionOptions/Arguments

Runs theMegaWizardPlug-InManager in command-
line mode, without displaying the GUI.

-silent

Specifies a.txt name that contains all the parameter
and port values.

-f:<parameter file>

Specifies the default working directory that qmegawiz
uses when it generates files.

-p:<working directory>
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DescriptionOptions/Arguments

Specifies themodule or wizard name.When there are
multiplewizard names that correspond to onemodule
name, use the wizard option to specify one wizard.
When there are multiple module names that
correspond to one wizard name, use the module
option to specify one module.

module=<module name>

wizard=<wizard name>

Specifies the parameter values.<param>=<value>

Specifies whether the ports are used.<port>=<used>|<unused>

Specifies a variation file name. Valid extensions are
.v, .vhd, or .tdf.

<variation file name>

For example,

qmegawiz -silent module=altlvds_rx wizard=altlvds
    common_rx_tx_pll=ON tx_coreclock=used lvds_sample.v 

Related Information
Command-Line Scripting

Using IP-generate Command-Line Executable
You can use ip-generate to create or modify custom megafunction variations. To run the ip-generate
command, follow these steps:

1. Type the following command at the command prompt of your operating system:
<ACDS installation directory> \quartus\sopc_builder\bin\

2. To run the executable type ip-generate.
3. To instantiate the megafunction using the executable file, type the following syntax:ip-generate

--component-name=altdq_dqs2 -–component-system-
param=DEVICE_FAMILY=”Stratix V” -–file-set=QUARTUS_SYNTH --output-
name[=<file_name>] –-component-
param[=<parameter_name>][=<parameter_value>]

Related Information
Command-Line Scripting

IP-Generate Arguments
IP-generate accepts these common arguments.
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DescriptionOptions/Arguments

Specifies the megafunction variant name.--component-name=<variant name>

Aparameter that is used by the ip-generator to specify
an output file. Valid extensions are .v, .sv, .vhd, or
.tdf.

-–file-set=QUARTUS_SYNTH
--output-name[=<file_name>]

Specifies the target device family.-–component-system-param=DEVICE_FAMILY
=”<device family name>”

Specifies the target device family.–-component- param[=<parameter_name>]
[=<parameter_value>]

Synthesizing Megafunctions in other Tools
You can use supported EDA tools to synthesize your design that includesmegafunctions.When you generate
non-hardware Tcl megafunctions for use with third-party EDA synthesis tools, you can optionally create a
netlist for area and timing estimation in addition to the standard generated wrapper file for place and route.

The netlist file is a representation of the custom IP logic implemented by the Quartus II software. The file
describes the connectivity of architectural elements in the megafunction but does not provide all details
about true functionality (grey box). This information enables certain third-party synthesis tools to better
report area and timing estimates. In addition, synthesis tools can use the timing information to achieve
timing-driven optimizations and improve the quality of results.

The netlist file is called <variant name>_syn.v file. The Quartus II software generates this file in Verilog
HDL format regardless of the output file format you specify. If you use this netlist for synthesis, you must
include the megafunction wrapper file <variant name>.v or <variant name>.vhd in your Quartus II project
for placement and routing.

Related Information
Synthesis, Quartus II Handbook

Simulating Megafunctions
You can simulatemegafunction IP cores in your design in supported EDA simulators. Altera provides various
tools to help you quickly setup and run simulation. TheNativeLink feature launches your preferred simulator
from within the Quartus II software and automates the compilation and simulation of testbenches.
Alternatively, the Simulation Library Compiler automatically compiles and stores the correct simulation
model libraries for functional and gate-level timing simulation of your design. The most recent Altera
megafunctions are based on the Hardware Component Description File (_hw.tcl) infrastructure. Older
Altera megafunctions are based on HDL code. The megafunction infrastructure determines the simulation
tool flow.
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Simulation Flow(s)IP Infrastructure

Generate your IP core and add the generated .qip file to your
project, enabling you to use automated NativeLink
simulation.

Or

Use the simulation script templates providedwith the IP core
to set up the simulation environment for your chosen
simulator. The scripts compile the required device libraries
and system design files in the correct order and elaborate or
load the top-level design for simulation.

Hardware Tcl

Use NativeLink to automatically generate scripts to set up
and launch your preferred EDA simulator with the Quartus
II NativeLink feature,manually set up EDA simulation using
the Simulation Library Compiler, or manually set up EDA
simulation by writing your own ModelSim script (for
ModelSim- Altera software only) to set up the simulation
environment.

Non-Hardware Tcl

Related Information
Simulating Altera Designs, Quartus II Handbook
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